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Horiba Jobin-Yvon  
LabRAM Aramis - Raman Spectrometer 

 
The Aramis Raman system is a software selectable multi-wavelength Raman system with 
mapping capabilities with a 400mm monochromator and CCD detector.  Mapping is 
possible through a motorized stage for mapping with “autofocus” and DuoScan laser 
rastering for mapping within the objective field of view. 
  
 System specs: 
  Lasers: 325nm, 532nm, 633nm, and 785nm 
  Gratings: 300g/mm, 600g/mm, 1800g/mm, 2400g/mm 
  Objective lens: 10x, 50x, 100x, 40x (for UV work) 
 
The Raman scattering technique is a vibrational molecular spectroscopy which derives 
from an inelastic light scattering process. With Raman spectroscopy, a laser photon is 
scattered by a sample molecule and loses ( or gains) energy during the process. The 
amount of energy lost is seen as a change in energy (wavelength) of the irradiating photon. 
This energy loss is characteristic for a particular bond in the molecule. Raman can best be 
thought of as producing a precise spectral fingerprint, unique to a molecule or indeed and 
individual molecular structure.  
 
Prerequisites for operating the Aramis system: 
a) Obtain a NRF ID (if you do not already have one) by completing the NRF Lab Use 

Request Form and safety training. 

b) Receive “one on one” training and certification from NRF Staff.  Discuss your process 
with a staff member.  

Safety 
• Laser emission – The user must be aware of laser emission from the Aramis system at 

all times.  The system is safety interlocked to prevent laser emission while the 
microscope stage doors are open.  Anyone caught defeating this safety interlock will 
have access to this system revoked. 

 

 
 

The LabRAM ARAMIS operates with laser sources emitting visible or invisible 
continuous laser radiation typically below 300 mW.  The LabRAM ARAMIS is a fully 
enclosed instrument providing no access to the laser beam. Safety switches placed on 
the doors of the instrument turn the laser off instantly when opened, and allow the user 
to operate the instrument safely. 

DANGER! Do not remove the covers of the instrument. Do not modify the instrument. 
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• Moving Components - The User must observe caution when loading and unloading 
samples from the sample stage.  The X, Y, and Z position are only to be moved by 
joystick control.  Manual stage movement will damage the X and Y motors.  Course 
focusing can be performed by using the left side focus knob (located on the left side 
below the sample stage), fine focus should be accomplished by using the joystick 
control. 

 
1.0   Pre-Operation  

1.1 Tool Reservations may be made via the NRF Reservation Page.  
 http://nimet.ufl.edu/servicecenter/resources/default.asp 

1.2 Change gloves.  WARNING No solvents or liquids are allowed near the machine,  
 change your gloves before operation!!  

1.3 Log into the tool by using the TUMI computer in room 125. 

  
 
2.0   Hardware Overview Images 
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3.0  User Interface Overview 
 

3.1  Overview  
 LabSPEC 5 – the software used to run the LabRAM spectrometer – can be found on 

the desktop.  The software user interface consists of four control panels (labeled here 
as:  Data Selection, Scale, Scan Controls, Data Processing, and Spectrometer 
Parameters).   See below for descriptions of useful functions for basic operation. 

 

 

 

 

Data management toolbar becomes visible on the right side of the software window 
once data spectra are open.  This provides toggling between different data plots or 
allows multiple plots in one window.  Useful when saving data since only highlighted 
window and current data plot are saved. 
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 3.2 Spectrometer Parameter Toolbar: 
 

 

A. Laser selection: 785nm , 633nm (listed as “HeNE”), 532nm , 325nm (listed as 
“External Laser”) 

B. Neutral density filter selection (see below for selection) 

C. Confocal hole size (25µm to 500µm) 
D. Grating center position – only useful for alignments 
E. Grating selection (300g/mm, 600g/mm, 1800g/mm, 2400g/mm)  

 
Grating type Spectral range Notes 
300 g/mm 0nm to 5700nm - 
600 g/mm 0nm to 2856nm Best for visible low resolution 

1800 g/mm 0nm to 952nm Best for visible high resolution 
2400 g/mm 0nm to 714nm Best for UV, high resolution 

 
Microscope objective lens: 10x(yellow), 50x (blue), 100x(white), 40x (black) for 
UV only.  CAUTION: the 40x, 50x, and 100x have very short working distances 

  Filename 
F. Acquisition  

  Continuous mode time (seconds) – only useful for alignments 
  Snapshot time (seconds) 
  Number of accumulations (for averaging, typically set to 2) 

G. Stage position (Click the star to zero the position) units are µm 
H. Laser shutter OPEN/CLOSE, and Setup.  In the Setup menu, you will select 

between visible and UV work and between DuoScan or normal scan control 
 

 

 
 
  

Filter number Percent transparency 
D 0.3 50% 

D 0.6 25% 
D 1 10% 
D 2 1.0% 
D 3 0.1% 
D 4 0.01% 
--- No filter 
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 3.3 Scan Controls toolbar: 
 

 

A. Begins continuous mode acquisition (continuous scanning).  Useful for 
alignments and calibrations. 

B. Begins snapshot mode acquisition (single scan) 
C. Begins mapping mode acquisition 
D. Mapping mode parameter menu 
E. Snapshot mode parameter menu 
F. Activates white-light imaging camera  (NOTE:  Camera must be turned off before 

 data acquisition begins) 
 
 

 

 3.4 Scale toolbar: 
 

 

 

A. Fits spectrum or image so that all acquired data fits into the window. 
B. Normalizes only with respect to intensity (i.e. does not adjust the x-axis) 
C. Centers the data selection lines 
D. Retrieves all saved parameters about the selected spectrum 
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4.0  Operation for Basic Raman and PhotoLuminescence 
 
 4.1 Power on system 

 a. Computer, system power, stage power and CCD power should be on already.  Check 
  the CCD temperature, lower right bottom of the LabSpec 5 software page.  The  
  appropriate temperature will be -70C or lower. 
 

CAUTION        CAUTION 
 

CCD MUST BE AT LOW TEMPERATURE TO PROPERLY OPERATE.   
HIGHER TEMPERATURES WILL INCREASE THE BACKGROUND NOISE  

AND INCREASE A CHANCE OF DAMAGING THE CCD. 
 
 b. Power on the lasers you will be using: 

785nm – Turn on the main power, wait until the system has initialized, then press 
the “laser ON/OFF” button. (system will read: “Act  200mA”) 

633nm – Turn the key. 
532nm – Turn the key, wait for system to initialize, press “Enable”. (system will 

read: “Laser Emission”) 
325nm – Turn the key, laser will start in a few moments  Please allow 30 minutes 

for this laser to fully energize. 
 c. Full screen the LabSpec 5 software.  If needed, open “LabSpec 5” from the desktop. 

 
 4.2 Sample loading 

 a. Turn on white lamp, either top or bottom illumination.  Typical setting is 4 to 6. 
 b. Click the “Video” icon (Scan Control Toolbar – F) to open white light shutter and start  
  the imaging 
 c. Close the laser shutter prior to opening the doors to the microscope stage   
  (Spectrometer Parameter Toolbar - H).  This is to ensure the laser will not be  
  transmitted through the objective lens. 
 d. Select the appropriate objective lens on the microscope.  Select the corresponding  
  objective lens on the computer (Spectrometer Parameter Toolbar – E, objective  
  lens).  This places the correct scaling on the image 
 e. Load sample onto the stage.  There is a tab to hold a standard glass slide.  Care  
  should be taken to avoid touching the end of the objective lens. 
 f. Using the joystick control, bring sample into approximate focus position with the Z 

knob rotation.  DO NOT USE THE MANUAL Z STAGE FOCUS KNOB!! 
 

CAUTION        CAUTION 
 

DO NOT CRASH OBJECTIVE LENS INTO THE SAMPLE OR STAGE!   
 



Horiba LabRAM ARAMIS – Raman Spectrometer                           Revision 2.8       02/08/2021     
                                                               Page 8 of 12 
 

 g. To move the sample stage in X,Y, and Z, you must use the stage joystick.  Manual 
stage movement will damage the stage motors. 

 

CAUTION        CAUTION 
 

THE JOYSTICK CONTROL IS SENSITIVE TO MOVEMENT.  SMALL MOVEMENTS 
IN X AND Y RESULT IN SLOW STAGE TRAVEL.  LARGER JOYSTICK  

MOVEMENT RESULTS IN FASTER STAGE TRAVEL.   
SAME FOR Z TRAVEL WITH ROTATION OF XY JOYSTICK KNOB. 

 
 h. Use the video screen and the joystick to bring the sample surface into optical focus. 

A clockwise knob twist lowers the stage while a counterclockwise twist will 
raise the stage.   

 

NOTE:  Z - Stage Drift possible 
 

It is possible that the stage can drift in the z-direction over time (generally the stage 
drifts down with respect to the objective lens).  This can make it difficult to obtain 
consistent data during long acquisitions.   Use the following 3-step procedure to 
minimize Z-drift when focusing: 
 
1) Focus in on the sample by turning the joystick counterclockwise to move  the 
 objective lens closer to the sample. 
2) Once a coarse focus is obtained, make any minor adjustments necessary  by 
 toggling the focus. 
3) Finally, be sure that the last adjustment is a counterclockwise turn of the 
 joystick.  This will ensure the stage gears are engaged before coming to a  stop. 
 
You can test the z-drift by comparing the laser focus before and after a typical 
measurement.  If significant drift persists with this procedure, please notify NRF 
staff. 

 

 

4.3 Selecting and focusing the laser 
 a. Select the laser from the pull down menu (Spectrometer Parameter Toolbar - A)  Wait 
  for the system the adjust internal optics. 
 b. Open the laser shutter (Spectrometer Parameter Toolbar - H).  The green dot in the  
  center of the image is the approximate laser spot position. 
 c. Focus the laser with the joystick by twisting the joystick knob.  (A good focus will have 
  a small dark spot surrounded by bright annular rings in the center of the video)   
  Typically a focused image is not a focused laser spot. 
 d. Close laser shutter.  The position of this shutter before a data scan will determine the  
  position after the scan.  Closed shutter before scan and software will close  
  shutter after scan.  This can reduce sample damage on sensitive samples.  
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 e. Enter the “Setup” menu (Spectrometer Parameter Toolbar – H, Setup) and select UV  
  (for 325nm laser) or Visible (for all other lasers). 

 

4.4 Collecting Data: 
  
 4.4.1 Area of interest 
  Find you area of interest using the Video image and the joystick to move the  
  sample stage.  Place the area of interest under the green dot (middle of the  
  image).  Turn off “Video” by clicking the “STOP” icon on the top tool bar.  The last 
  image will freeze and the white light shutter will close. 
 

To save the image of your area of interest , highlight the video box.  Under the 
“File” menu, select “Save As”.  Choose an image file type and save the image in 
your user directory within the “Data” folder on the desktop.  This image will not 
have the xy axis or the scale bar.   
 
To save the image with scale bar, choose “Save Picture as” under the File menu. 
This used the .wmf extension and the saved image will incorporate the xy axis 
and scale bar. 

 
 4.4.2 Basic Raman Analysis: 
  a. Open the “Options” menu, top menu of LabSpec5 software.  Click on “units”  
   and select “cm-1” .  This puts the system in a narrow spectrum scan  
   mode for Raman. 
  b. Select the N.D. filter (Spectrometer Parameter Toolbar - B) 
  c. Select the confocal hole size (Spectrometer Parameter Toolbar –C) 
   

To acquire a range of data, open Snapshot Mode Parameter menu (Scan Control 
toolbar – E).  This will bring up the Extended Range menu displayed below.  
Select the spectral range and time percentage.  You may also select to acquire 
several windows of data.  The Mode should either read “Single Scan” or “Multi 
window”. 
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CAUTION        CAUTION 
 

Leave the “min overlap (pix)” at 100! 
 

  e. Select grating pitch density (Spectrometer Parameter Toolbar – E, Grating) 
  f. Select file name prefix (Spectrometer Parameter Toolbar - E, Data name) 
  g. Select the real time data exposure time in seconds (Spectrometer Parameter  
   Toolbar – F, RTD Exposure time) 
  h. Select the data acquisition exposure time in seconds (Spectrometer Parameter 
   Toolbar – F, Exposure time) 
  i. Select the number of accumulations for each data point (Spectrometer   
   Parameter Toolbar – F, Accumulation number) 
 
  IMPORTANT:  Click “Stop” button in upper right hand corner to ensure video  
     mode is off. 
  k. Click Spectrum Acquisition (Scan Control toolbar - B). 

 

 4.4.3 Basic PL Analysis 
  a. Open the “Options” menu, top menu of LabSpec5 software.  Click on “units”  
   and select “nm” or “eV” units.  This puts the system in a wider spectrum  
   scan mode for PL. 
  b. Select the N.D. filter (Spectrometer Parameter Toolbar - B) 
  c. Select the confocal hole size (Spectrometer Parameter Toolbar –C) 
   

To set the range of data, open Snapshot Mode Parameter menu (Scan Control 
toolbar – E).  This will bring up the Extended Range menu displayed below.  
Select the spectral range and time percentage.  For one scan, leave the Time 
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(%) at 100.  You may also select to acquire several windows of data, all the 
windows should add to 100%.  For best PL results, select “autoscan” in the Mode 
dropdown menu.  This will eliminate non-uniformity in the CCD. 

 

 

CAUTION        CAUTION 
 

Leave the “min overlap (pix)” at 100! 
 
  e. Select grating pitch density (Spectrometer Parameter Toolbar – E, Grating) 
  f. Select file name prefix (Spectrometer Parameter Toolbar - E, Data name) 
  g.  Select the real time data exposure time in seconds (Spectrometer Parameter  
   Toolbar – F, RTD Exposure time) 
  h. Select the data acquisition exposure time in seconds (Spectrometer Parameter 
   Toolbar – F, Exposure time) 
  i. Select the number of accumulations for each data point (Spectrometer   
   Parameter Toolbar – F, Accumulation number) 
 
  IMPORTANT:  Click “Stop” button in upper right hand corner to ensure video  
     mode is off. 
 
  k. Click Spectrum Acquisition (Scan Control toolbar - B). 
 
 4.4.4 Saving data sets 
 In order to save a data set, that data set must be highlighted.  If multiple data 
 sets are open, the desired data set can be selected using the right side vertical 
 toolbar.  Each data set will be represented by a different color circle.  Each data 
 set must be saved separately. 
 
 a. Select desired data set to be saved 
 b. Under “File” on the top menu, select “Save As”. 
 c. It is recommended that each data set be saved in the labSpec5 extension .ngs 
 d. For a column data format, select .txt for a data only output file.  This data set  
  can be imported into a spreadsheet program for plotting. 
  NOTE: make sure the “Save Axes” box is checked to save .txt data format 
 
 NOTE: Please save data to the DATA folder on the desktop.  You may create a 
 separate folder for your data within this DATA folder.   

 

 

5.0 Shutdown 
 a. Turn off the lasers: 

785nm – Turn off the laser with the “laser ON/OFF” button (system will read: “Act  
0mA”), then turn off the main power.  

  633nm – Turn the key off 
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  532nm – Turn the key off 
  325nm – Turn the key off.  Fan will continue to run for several minutes, 
 b. Remove sample from sample stage.  First lower the stage completely to safely  
  remove the sample.  Close doors to the microscope stage 
 c. Leave the LabSpec5 software open, it can be minimized if desired. 
 d. Copy data to a removable memory drive. 
 e. Log out using TUMI laptop in Lab 125 
 
 
6.0 Troubleshooting 
 The Horiba Aramis system is designed to be a simple interface, multiuser instrument.  
 If issues occur during data collection or general operation, please close the LabSpec5 
 software (do not reboot the computer) and restart the software.  This will reinitialize 
 communication with the instrument and will most times correct the issue.  If this does 
 not correct the issue, shut down instrument and contact NRF staff. 
 
7.0 Laser power output 

The laser power was measured at the objective lens, which is less than the list raw 
output laser power for each laser.  The laser output is what the manufacturer has listed 
for this laser source. 
 
325nm – 34mW laser output, 20mW at objective 
532nm – 100mW laser output, 60mW at objective 
633nm – ##mW laser output, ##mW at objective 
785nm – 200mW laser output, 95mW at objective 

 


